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Legal Disclaimer
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All forward-looking statements are subject to various risks and uncertainties that could cause actual results to differ materially from expectations. Readers are cautioned not to place undue reliance on these forward-looking statements, which speak only as of their dates, and they should not be relied upon in making purchasing decisions.
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[bookmark: _Toc516648434][bookmark: _Toc11147450][bookmark: _Toc93667390]Release Notes
This document contains shared release notes and planned changes. Shared release notes and planned changes document features and changes that apply to SAP Concur solutions site-wide or to multiple SAP Concur products and services. They include but are not limited to:
· Security-related features and changes such as annual security certificate renewals and changes in support for security ciphers and protocols
· Site-wide UI features and changes such as changes to the home page, changes to the site header or footer, or the implementation of new site-wide UI themes
· Sign-in process features and changes such as the addition or removal of sign-in features, URL changes, and domain name changes
· Production and test environment features and changes
· Global settings or administration page features and changes such as the addition of new site-wide settings or changes to the design of the administration pages
· Changes to processes such as where and when release notes are published
For New Features and Changes that apply to a single product and/or service see the release notes for that product or service. Links to the product and service-specific release notes can be found on the following pages:
Professional Edition
Standard Edition
Small Business Edition
[bookmark: _Toc93667391]File Transfer Updates
[bookmark: _Toc93667392]**Ongoing** Rotating PGP Key for File Transfers

	[bookmark: _Hlk92987153]Information First Published
	Information Last Modified
	Feature Target Release Date

	February 2021
	January 21, 2022
	January 15, 2021 and October 11, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93667393]Travel, Expense, Invoice, Request, Intelligence | Professional & Standard
Overview
Files transferred to SAP Concur products must be encrypted with the SAP Concur public PGP key, concursolutionsrotate.asc. 
concursolutionsrotate.asc 
· Key file is available in client’s root folder
· Key ID 40AC5D35
· RSA 4096-bit signing and encryption subkey
· Key expires every 2 years
· Client is responsible for replacing the key before it expires
Next expiry date: September 4, 2022
SAP Concur plans to replace the current rotating public PGP key in the client’s root folder 90 days before the expiration date
The SAP Concur legacy PGP key (key ID D4D727C0) will be decommissioned on October 11, 2022. You must switch to using the rotating PGP key before that date. Files encrypted with the legacy PGP key will not be processed after October 10, 2022.
This announcement pertains to the following file transfer DNS endpoints:
· st.concursolutions.com
· mft-us.concursolutions.com
· vs.concursolutions.com
· st-eu.concursolutions.com
· mft-eu.concursolutions.com
Business Purpose / Client Benefit
The rotating public PGP key provides greater security for file transfers.
What the Administrator Sees
An administrator with the required file transfer credentials can log into the file transfer site to retrieve the rotating public PGP key, concursolutionsrotate.asc, from the root directory.
Configuration / Feature Activation
Your internal file transfer administrator can add the key to their PGP keyring and start using it to encrypt any files being transferred to SAP Concur. 
If assistance is required, please contact SAP Concur support.
For more information, refer to the Shared: File Transfer for Customers and Vendors User Guide.
[bookmark: _Toc93667394][bookmark: _Hlk34219283]**Ongoing** SAP Concur Legacy File Move Migration

	Information First Published
	Information Last Modified
	Feature Target Release Date

	March 6, 2021
	January 14, 2022
	January 24, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.



[bookmark: _Hlk93481970]Applies to:
[bookmark: _Toc93667395]Travel, Expense, Invoice, Request, Intelligence | Professional & Standard
Overview
This release note is intended for the technical staff responsible for file transmissions with SAP Concur. For our clients and vendors participating in data exchange, SAP Concur is maintaining our file transfer subsystem to provide greater security for those file transfers. 
SAP Concur is in the process of migrating entities that currently use a legacy process for moving files to a more efficient and secure file routing process that relies on APIs. 
Clients whose entities are currently configured to use the legacy process will be migrated to the more efficient process sometime between now and January 24, 2022. After they are migrated to the more efficient process, clients will see the following improvement:
· With the legacy process, clients had to wait for the file move schedule to run at a specified time. With the more efficient and secure API-based process, extracts and other outbound files from SAP Concur will be available within the existing overnight processing period shortly after the files are created.
This announcement pertains to the following file transfer DNS endpoints:
· st.concursolutions.com
Business Purpose / Client Benefit
These changes provide greater security and efficiency for file transfers.
Configuration / Feature Activation
If assistance is required, please contact SAP Concur support.
For more information, refer to the Shared: File Transfer for Customers and Vendors User Guide.
[bookmark: _Toc93667396]Miscellaneous 
[bookmark: _Toc93667397]**Ongoing ** SAP Concur Homepage Changes

	Information First Published
	Information Last Modified
	Feature Target Release Date

	October 8, 2021
	January 14, 2022
	Q4 2021 – Q2 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93667398]Travel, Expense, Invoice, Request | Professional & Standard
Overview
In Q4, 2021, SAP Concur began redirecting clients to a new homepage. The appearance of the new homepage is identical to the previous SAP Concur homepage. The new homepage has enhanced functionality when services become temporarily unavailable.
The roll out of the new homepage is phased:
Phase 1: At the beginning of Q4, SAP Concur began redirecting Concur Expense, Concur Invoice, and Concur Request clients in the US Datacenter to the new homepage. 
Phase 2: In December 2021, SAP Concur will begin redirecting Concur Expense, Concur Invoice, and Concur Request clients in the EU Datacenter to the new homepage.
Phase 3: In Q2 of 2022, SAP Concur will begin redirecting the remaining clients in the US and EU datacenters to the new homepage. The remaining clients include those with Concur Travel standalone or Concur Travel with Expense, Invoice, and/or Request.
Business Purpose / Client Benefit
This change ensures that the SAP Concur homepage is available even when some services are unavailable and improves the consistency of the sign in experience.
What the User Sees
With the old homepage, when a user signs into their SAP Concur products, they see their homepage.
The appearance of the homepage varies depending on which products and services are enabled for the client and the permissions assigned to the user.

If some products or services are unavailable while other products and services are up and running, a modified version of the user’s homepage similar to the following appears: 
[image: ]
After a client is migrated to the new homepage, if one or more services are unavailable, when a user signs in to their SAP Concur products, they will see the usual homepage, but if the user navigates to a page for a service that is unavailable, they will see a page similar to the following:
[image: ]
After migration to the new homepage, if all services are available, this change is transparent to the user and they see a homepage that is identical to the pre-migration homepage.
Example Homepage

Configuration / Feature Activation
This change occurs automatically; there are no configuration or activation steps.
[bookmark: _Toc93667399]**Ongoing** Changes to Page Header and Profile Menu

	Information First Published
	Information Last Modified
	Feature Target Release Date

	January 21, 2022
	--
	Q1 – Q2 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93667400]Travel, Expense, Invoice, Request | Professional & Standard
Overview
Beginning in Q1 2022, the following changes will be made:
· The greeting on the SAP Concur Homepage will be removed
· If a user has entered a nickname/preferred name on the Profile – Personal Information page in Profile Settings, their nickname/preferred name will be displayed in the Profile menu.
Business Purpose / Client Benefit
This change reflects the users preferred name in the user interface.
What the User Sees
When the user signs in to their SAP Concur solutions, they will no longer see the phrase "Hello, <firstname>" on the home page.
Current View
[image: ]
Currently, when a user clicks on Profile, their full name is displayed.
Current View
[image: ]
After these changes have been implemented, if the user has specified a nickname/preferred name on the Profile – Personal Information page in Profile Settings, when they click on Profile, their nickname/preferred name will be displayed. 
If the user has not specified a nickname/preferred name, when they click on Profile, their first name will be displayed.
Configuration / Feature Activation
This change occurs automatically; however, this change will be implanted in the new homepage which is being rolled out in phases. 
[bookmark: _Toc93496705]For information about the release timeline for the new homepage, refer to the **Ongoing ** SAP Concur Homepage Changes release note in this document.
[bookmark: _Toc93667401]Product Settings
[bookmark: _Toc93667402]Product Settings Page Enhancements

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 13, 2021
	January 14, 2022
	January 27, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93667403]Expense, Invoice, Request | Standard
Overview
The Product Settings page in Concur Standard Edition has been enhanced. 
Business Purpose / Client Benefit
These changes improve the functionality of the Product Settings page.
What the Admin Sees
A user with the required administration permissions sees the following enhancements:
· If any required information is missing from the Accounting, Expense Types for Expenses, Employee Reimbursements, Expense Approvals, Payment Types, User Accounts, or VAT settings pages, an alert appears at the top of the Product Settings page and on the tile for the affected setting.
For example, if Expense Types have not yet been mapped to Account Codes on the Expense Types for Expenses page, an alert appears at the top of the Product Settings page and on the Expense Types for Expenses tile.
· If required information is missing from a settings page, an alert appears at the top of the affected settings page.
For example, if VAT configurations have not yet been set up, an alert appears at the top of the Taxation – VAT Tracking page.
Configuration / Feature Activation
These enhancements are implemented automatically; there are no configuration or activation steps.
[bookmark: _Toc93667404]SAP Concur User Assistance
[bookmark: _Toc93667405]Shared Planned Changes Moved to New Shared Changes Release Notes

	Information First Published
	Information Last Modified
	Feature Target Release Date

	December 3, 2021
	January 14, 2022
	January 14, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93667406]All Products and Services | All Editions
Overview
Beginning with the January 2022 draft release notes, shared (SAP Concur cross-product) changes, shared planned changes, and changes to SAP Concur core technologies are published in a new document, Shared Changes Release Notes. This document replaces the current Shared Planned Changes Release Notes.
Shared and core technology features and changes include, but are not limited to:
· Security-related changes—for example, annual security certificate renewals, changes to support for security ciphers, changes in support for security protocols, and changes to username and password requirements.
· UI design changes that impact all products—for example, changes to the functionality or appearance of the SAP Concur home page, the addition or removal of links from the site header or footer, changes to the user profile. page, and theme changes that impact the overall look and feel of the SAP Concur site.
· Sign-in process changes—for example, the addition or removal of sign-in features, URL changes, domain-name changes, and changes to verified email.
· Changes to production or test environments.
· Changes that impact site-wide settings, changes to global settings, and changes to pages for configuring site-wide or global settings—for example, changes to the User Administration page, changes to Product Settings for Standard Edition, and the introduction of new administration tools.
Previous Process
SAP Concur User Assistance published the Shared Planned Changes Release Notes in coordination with each monthly release. This document included shared and core features and changes that SAP Concur plans to implement in the future. When those changes were officially released, the release or implementation of the change was distributed and documented in the product-specific release notes—for example, the Concur Expense, Concur Invoice, Concur Request, or Concur Travel release notes.
New Process
Beginning in January 2022, the implementation of shared and core features, and changes to existing shared and core features are now documented in the new Shared Changes Release Notes. This applies both when the features and changes are planned changes and when they are officially released. The shared/core release notes will no longer be distributed to product-specific release notes.
Changes that are specific to one product and that impact that product's functionality or UI for admins or for end users will continue to be documented in that product's release notes.
Business Purpose / Client Benefit
This change reduces duplication of information, ensures that the product-specific release notes contain product-specific information, and provides a single source for SAP Concur shared changes and changes to core technologies.
Configuration / Feature Activation
This process change occurred automatically.
[bookmark: _Toc93667407]SAP Fiori Themes
[bookmark: _Toc93667408]New SAP Fiori Themes Available for Preview

	Information First Published
	Information Last Modified
	Feature Target Release Date

	January 14, 2022
	--
	January 22, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93667409]Travel, Expense, Invoice, Request | Professional
Overview
On September 20, 2021, a new permission, SAP Fiori Theme Preview, was added to the list of permissions in Concur Travel Professional edition. The SAP Fiori Theme Preview permission enables an SAP Concur client admin to allow users to preview and test the SAP UI themes in their SAP Concur site.
Initially, only the SAP Quartz Light theme was available. With the January 2022 release, a new list field, Appearance Settings, has been added to the Profile Settings > System Settings page, and users who have been assigned the SAP Fiori Theme Preview permission can choose from the following list of SAP themes:
· SAP Quartz Light
· SAP Quartz Dark
· High Contrast White
· High Contrast Black
Business Purpose / Client Benefit
SAP themes harmonize the look and feel of the SAP Concur UI with the look and feel of other SAP products, providing a more consistent user experience. Some themes also better support high contrast requirements and low light environments. 
What the User Sees
By default, when the New Theme switch is toggled to On, the SAP Concur UI is set to the SAP Quartz Light theme. The user can then choose from a list of available themes by navigating to Profile Settings > System Settings.
To Switch SAP Themes
1. Toggle the New Theme switch to the On position.
[image: The switch is toggled to the On position.]
2. On the Changing Theme Requires Page Refresh screen, click Continue.
[image: Changing themes requires the page to refresh. Any unsaved data on this page will be lost. Are you sure you want to continue?]
3. Click the Profile icon in the upper left corner of the header bar.
[image: The Profile icon is clicked.]
4. Click Profile Settings.
[image: Profile Settings is clicked.]
5. On the Profile Options page, click System Settings.
[image: System Settings is clicked.]
6. On the System Settings page, in the Available Settings list, select the theme you want to use.
[image: The user clicks the desired item in the list.]
7. Click Save. The screen refreshes and the SAP Concur UI is set to the selected theme.
Configuration / Feature Activation
The Appearance Settings list is added to the System Settings page when a user with the SAP Fiori Theme Preview permission toggles the New Theme switch to the On position. 
[bookmark: _Toc93667410]Profile Menu Functional Changes Under Fiori Light Theme 

	Information First Published
	Information Last Modified
	Feature Target Release Date

	December 10, 2021
	January 14, 2022
	January 14, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93667411]Travel, Expense, Invoice, Request | Professional
Overview
With the January release, the Profile menu within the SAP Fiori theme has been updated. This update includes changes to the layout of the menu items and some changes in functionality.
Business Purpose / Client Benefit
The Profile menu within the SAP Fiori theme is now functionally more efficient and easier to use. 
The SAP Fiori theme harmonizes the look and feel of the SAP Concur offerings with those of other SAP products, providing a more consistent user experience.
What User Sees
With the new theme enabled, most users (users without rights to work on behalf of another) see options to access their personal profile settings and to log out of the product. The layout and appearance are changed, but the functionality remains the same.

	Current Theme
	SAP Fiori Light Theme

	[image: ]
	[image: ]


What the User with "Act as Another" Rights Sees
In addition to the Profile Settings and Sign Out option, users granted rights to work on behalf of another see the Act as Another User option.

	Current Theme
	SAP Fiori Light Theme

	[image: ]

	[image: ]
Clicking the arrow reveals the option to act on behalf of another user:
[image: ]


Functional changes to the Profile menu under the new theme include the following:
· Myself: This option serves two functions, the first to allow visual identification and confirmation that the user is working on their own behalf and the second, to enable the user to return to working on their own behalf after acting as another user. 
· Switch: This button toggles the user between working for a user and working on their own behalf. 
Switching Between Acting for Another User and Acting for Yourself
The function of acting for another user is almost identical between the current theme and the SAP Fiori Light Theme.

	Current Theme
	SAP Fiori Light Theme

	[image: ]
	[image: ]


There are minor differences including the following functional changes:
· Text: The wording on the Fiori interface is updated to better explain the action being taken.
· User Selection and Switch button: Here the actions of selecting a user and switching to act on their behalf are ordered on a single line and the Cancel button removed entirely. 
With the Fiori theme active, a user enters the name of the user they want to act for and, after selecting the user's name, clicks the Switch button to begin acting as the specified user. When acting as another user, the name of the user currently being acted for appears above the Profile menu.

	Current Theme
	SAP Fiori Light Theme

	[image: ]
	[image: ]


The user resumes acting on their own behalf by selecting the Myself option and clicking Switch.
Configuration / Feature Activation
There are no configuration or activation steps; the Profile menu in the SAP Concur Fiori Light Theme is automatically updated with the January 2022 release.
Clients who opt-in to preview the SAP Fiori theme and who want to provide feedback, can register on the following page to participate in the SAP Continuous Influence program: SAP Customer Influence

After registering or logging in, clients can request to participate in the Hands-on system Approach of Consistent User Experience based on SAP IE Scenario Travel-to-Reimburse opportunity.

Registration for this SAP Customer Influence opportunity is limited and may close.
For more information about acting as another user refer to Shared: Delegate Configuration Setup Guide and the Expense or the Invoice version of the Proxy Logon User Guide. For more information about the SAP Fiori theme see New Permission to Enable Preview of Fiori Light Theme in the December 2021 release notes.
[bookmark: _Toc93667412]Security
[bookmark: _Toc93667413]Some TLSv1.2 Ciphers No Longer Supported (Feb 1, 2022)

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 13, 2021
	January 14, 2022
	February 1, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93667414]Travel, Expense, Invoice, Request | All Editions
Overview
Beginning on February 1, 2022, SAP Concur solutions will no longer support connections to *.concursolutions.com and * api.concursolutions.com that use the following TLSv1.2 ciphers:
	Akamai/OpenSSL cipher name
	IANA cipher name

	AES256-GCM-SHA384
	TLS_RSA_WITH_AES_256_GCM_SHA384

	AES128-GCM-SHA256
	TLS_RSA_WITH_AES_128_GCM_SHA256

	ECDHE-RSA-AES256-SHA384
	TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384

	ECDHE-RSA-AES128-SHA256
	TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256

	ECDHE-RSA-AES256-SHA
	TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA

	ECDHE-RSA-AES128-SHA
	TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA


To ensure that connections to *.concursolutions.com and * api.concursolutions.com are not disrupted, clients and partners who connect to *.concursolutions.com and *api.concursolutions.com through an application that uses a retired cipher must update the application to a supported cipher before February 1, 2022.
Business Purpose / Client Benefit
This update provides ongoing security for our products and services.
Confirming Supported Ciphers
The following ciphers included in the ak-akamai-2020q1 cipher profile are supported:

	Akamai/OpenSSL cipher name
	IANA cipher name

	TLS-AES-256-GCM-SHA384
	TLS_AES_256_GCM_SHA384

	TLS-CHACHA20-POLY1305-SHA256
	TLS_CHACHA20_POLY1305_SHA256

	TLS-AES-128-GCM-SHA256
	TLS_AES_128_GCM_SHA256

	ECDHE-RSA-AES256-GCM-SHA384
	TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384

	ECDHE-RSA-AES128-GCM-SHA256
	TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256

	ECDHE-RSA-CHACHA20-POLY1305
	TLS_ECDHE_RSA_WITH_CHACHA20_POLY1305_SHA256


If your cipher suite includes both supported and unsupported ciphers, connections to *concursolutions.com through a web browser will not be disrupted. During the process of establishing the connection, the *concursolutions.com server will choose the most secure cipher in your cipher suite.
You can confirm that your cipher suite includes a supported cipher by cross-referencing the Akamai/OpenSSL cipher name with the IANA cipher name in the ak-akamai-2021 (default) column in the following table. 
Supported ciphers are indicated with a check mark.
[image: ] 
Testing Ciphers
The following procedure is intended for use by system administrators who want to test whether their cipher suite configuration will work correctly when connecting to SAP Concur solutions after support for the ciphers listed above has been removed. 
This procedure configures the system admin's local machine to connect to an akamai staging environment where support for the listed ciphers has already been removed. 
Summary of the procedure:
· Retrieve the IP address of the akamai production environment.
· Retrieve the IP address of the akamai staging environment.
· Redirect navigation to concursolutions.com to the akamai staging environment by editing the local Hosts file.
· Test a connection to concursolutions.com.
Confirm Your Cipher Suite is Working Correctly
Retrieve the IP Address of the Akamai Production Environment
Ping www.concursolutions.com
Windows: Open a Command Prompt window, type “Ping www.concursolutions.com” and then press Enter.
Mac: Open Terminal, type “Ping www.concursolutions.com” and then press Enter.
Example response
Pinging e7868.b.akamaiedge.net (23.46.104.197): 56 data bytes
64 bytes from 23.46.104.197: icmp_seq=0 ttl=50 time=125.070 ms
64 bytes from 23.46.104.197: icmp_seq=1 ttl=50 time=111.866 ms
64 bytes from 23.46.104.197: icmp_seq=2 ttl=50 time=111.967 ms
64 bytes from 23.46.104.197: icmp_seq=3 ttl=50 time=112.435 ms
Copy the highlighted address in the response.
Example address
e7868.b.akamaiedge.net
Retrieve the IP address of the akamai staging environment
1. In the Command Prompt or Terminal window, ping the copied address, but with “-staging” appended to “akamaiedge”.
Example Ping command
Ping e7868.b.akamaiedge-staging.net
Example response
Pinging e7868.b.akamaiedge-staging.net (104.76.225.252): 56 data bytes
64 bytes from 104.76.225.252: icmp_seq=0 ttl=50 time=118.809 ms
64 bytes from 104.76.225.252: icmp_seq=1 ttl=50 time=242.459 ms
64 bytes from 104.76.225.252: icmp_seq=2 ttl=50 time=112.145 ms
64 bytes from 104.76.225.252: icmp_seq=3 ttl=50 time=114.994 ms
Copy the highlighted IP address in the response.
Example IP address
104.76.225.252
Update the Local Hosts File
MAC:
1) Open Terminal
2) Type “sudo nano /private/etc/hosts” and then press Enter.
[image: ]
If prompted, enter your administrator password.
3) After the comments at the beginning of the file, add the IP address you copied in step 4, followed by “www.concursolutions.com”.
Comments are preceded with a hashtag (#). Your entry should not include the hashtag.
Example entry
104.76.225.252 www.concursolutions.com
4) Save the file (Ctrl-o) and close Terminal (Ctrl-x).
Windows:
Launch Notepad as administrator by typing “Notepad” into the Windows search bar, right-clicking Notepad in the search results, and then clicking Run as administrator.
[image: ]
If prompted, click Yes in the User Account Control window.
5) In Notepad, click File and then click Open.
6) Navigate to C:\\Windows\System32\drivers\etc and then, to the right of the File name field, choose All Files (*.*) from the menu.
[image: ]
7) Open the hosts file.
8) After the comments at the beginning of the file, add the IP address you copied in step 4, followed by “www.concursolutions.com”.
Comments are preceded with a hashtag (#). Your entry should not include the hashtag.
Example entry
104.76.225.252 www.concursolutions.com
[image: ]
9) In the File menu, click Save.
Connect to *concursolutions.com from the Local Machine
After configuring your local hosts file to direct connections to *concursolutions.com to the akamai staging environment, connect to *concursolutions.com from the local machine through the method you need to test. 
Your system administrator might need to test connections to *concursolutions.com made via an API call, connected application, or by navigating to the sign-in page through a web browser and signing in as an SAP Concur user.
Configuration / Feature Activation
To ensure that connections to *.concursolutions.com and * api.concursolutions.com are not disrupted, any applications that use an unsupported cipher must be updated to use a supported cipher before February 1, 2022.
If your cipher suite includes both supported and unsupported ciphers, connections to *concursolutions.com through a web browser will not be disrupted. During the process of establishing the connection, the *concursolutions.com server will choose the most secure cipher in your cipher suite.
[bookmark: _Toc93667415]Supported Configurations
[bookmark: _Toc93667416]Change in Support for Internet Explorer 11

	[bookmark: _Hlk92986314]Information First Published
	Information Last Modified
	Feature Target Release Date

	June 11, 2021
	January 14, 2022
	January 14, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93667417]Travel, Expense, Invoice, Request, Analysis/Intelligence | All Editions
Overview
[bookmark: _Hlk19876476][bookmark: _Hlk19876428]On January 1, 2022, SAP Concur began transitioning away from support for Internet Explorer 11 (IE 11). This change is in line with other SAP solutions, industry best practices, and Microsoft’s lifecycle policy for IE 11.
Until Cognos 11 has been rolled out for all Analysis and Intelligence clients, we will provide support and allow exceptions for investigation to issues related to Cognos 10 and IE 11. For more information, refer to the Cognos 11 User Interface Update FAQ.
After January 1, 2022, SAP Concur development teams will not design new features, user interface enhancements, or security or bug fixes with IE 11 in mind. Over time, new functionality and existing functionality might not work properly on IE 11.
SAP Concur users are not blocked from access when using IE 11. They can still sign in to their SAP Concur solutions. However, to ensure their users can continue to work successfully and securely with SAP Concur solutions, SAP recommends that clients move away from allowing the use of SAP Concur solutions on IE 11 and move to a more modern, supported browser. 
Business Purpose / Client Benefit
This change enables SAP to speed up adoption of the latest browser innovations and provide a stronger security posture.    
Configuration / Feature Activation
There are no configuration steps; these changes occur automatically.
For more information, refer to the Internet Explorer 11 Support Policy Change FAQ.
[bookmark: _Toc93667418]Test Entities | Production Sandbox Environment
[bookmark: _Toc88647380][bookmark: _Toc93667419]Permanent Test Entity Renamed to Production Sandbox Environment

	Information First Published
	Information Last Modified
	Feature Target Release Date

	January 21, 2022
	--
	Released

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Hlk93494818][bookmark: _Toc93667420]Expense, Invoice, Request, Intelligence | Professional
Overview
SAP Concur has renamed the Permanent Test Entity (PTE) service to Production Sandbox Environment (PSE). 
[bookmark: _Hlk93491870]A PSE is a copy of a client's SAP Concur production entity. Clients can use the PSE to set up and test new products, features, and services before introducing them into the production environment. The PSE can also be used to train users on SAP Concur products, features, and services.
PSEs support the following:
· Testing of features and functionality in an environment that is similar to their production environment
· Cognos reporting including custom reports
· The ability to refresh the customer data in the PSE with data from their production entity
Clients must open a support case to request a data refresh.
Clients can request up to four data refreshes during the annual period defined by their subscription term.
PSEs do not support the following:
· Contract Services
· Active monitoring/reporting of issues on Concur Open
· Additional support for configuration and testing of features
· Receipt images
· Travel system configuration or data
· Travel Profile v2, Request v4, and Identity v4 APIs
Business Purpose / Client Benefit
The Production Sandbox Environment enables clients to test and train on features and functionality without impacting their production environment.
Configuration / Feature Activation
The terminology change occurred automatically. For more information about setting up a PSE, contact your SAP Concur client account manager.
[bookmark: _Hlk92986554][bookmark: _Toc93667421]Test Entity (PSE) Data Maintenance and Entity Deletion (Dec 6)

	Information First Published
	Information Last Modified
	Feature Target Release Date

	December 3, 2021
	January 21, 2022
	Ongoing

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93667422]Expense, Invoice, Request, Intelligence | Professional
Overview
As part of SAP Concur routine data maintenance and operations, we will begin deleting stagnant data in SAP Concur Production Sandbox Environments (PSEs). 
Beginning December 6, PSEs that have not been signed in to within 180 days will be deleted. For example, if a PSE has not been logged into between June 9, 2021 and December 6, 2021, it will be deleted on December 6, 2021. 
As of January 2022, as part of this ongoing routine data maintenance, PSEs that have not been signed in to within 180 days will also be deleted on a regular basis as such data is considered to be stagnant in accordance with applicable law.  Any customizations to the PSEs will not be recoverable in the event of deletion.
1. The deletion of data or entities in the production sandbox environment has no impact on live production entities.
Business Purpose / Client Benefit
This maintenance activity supports SAP and client data compliance requirements by minimizing the retention of personal data outside of the live production environment.
Configuration / Feature Activation
These changes will occur automatically. For customers who are entitled to use the product sandbox environment, SAP Concur support can assist clients with a normal refresh of their current production data in their PSEs.
[bookmark: _Toc93667423]**Ongoing** Most Recently Used Lists Not Migrated

	Information First Published
	Information Last Modified
	Feature Target Release Date

	September 2021 
	January 21, 2022
	October 1, 2021 through mid-2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93667424]Expense, Invoice, Request | Professional
Overview
Some SAP Concur users use Product Sandbox Environment (PSE) entities to set up, test, and train on new configurations prior to deploying them to their live production entity. SAP Concur plans to migrate PSEs as part of our move to Amazon Web Services (AWS).
For more information, refer to the SAP Concur Cloud Platform Strategy FAQ.
Due to the architectural changes that SAP Concur must make to support this move, when PSEs are migrated to the new environment, some Most Recently Used (MRU) list items within the PSE will not be migrated.
MRU lists consist of recent selections made by the user. These lists are generated overtime as users interact with various menus and other defined lists and they will be regenerated after the PSE is migrated to the new environment.
These changes apply to PSEs once they are moved or created in the AWS environment, which will occur at a future date.
Business Purpose / Client Benefit
Once in AWS, PSEs benefit from the same stability, monitoring capabilities, and level of performance as production entities.
What the User Sees
After the migration, some MRU lists that were generated prior to the migration will be empty. These lists will be regenerated automatically through the normal use of the PSE.
The following screenshots show some examples of MRU lists that will be impacted by the migration:
Create New Expense in Concur Expense
[image: ]
New Segment in Concur Request
[image: ]
Configuration / Feature Activation
This change occurs when a PSE is migrated to the new AWS environment; there are no configuration or activation steps. The MRU lists will be regenerated with normal user of the entity.
[bookmark: _Toc93667425]**Ongoing** Product Sandbox Environment Login Updates

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 2021 
	January 21, 2022
	October 1, 2021 through mid-2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93667426]Expense, Invoice, Request | Professional
Overview
Some SAP Concur users use Product Sandbox Environment (PSE) entities to set up, test, and train on new configurations prior to deploying them to their live production entity. SAP Concur plans to migrate PSEs as part of our move to Amazon Web Services (AWS).
For more information, refer to the SAP Concur Cloud Platform Strategy FAQ.
Today, a user can maintain the same login ID for their test and production entities because they are in separate environments. With the plan to migrate both test and production entities to the same AWS production environment in the future, this will no longer be possible since each login ID must be unique. 
While there is no action required for customers regarding this update, we want to ensure customers are aware of it because the change will be visible in certain areas of PSEs. To account for this change, SAP Concur will append all PSE login IDs with a ".uat” domain during both migration and user creation to ensure they are unique and do not conflict with any existing production login ID. For example, johnsmith@123.com will become johnsmith@123.com.uat.
IMPORTANT: No changes will made to the login IDs in the current implementation environment in our private data centers.

This process will occur in the background during both the migration and user creation processes. Because SAP Concur will manage this process, users will NOT have to make any changes to their login ID. 

Migrated users will still use the same implementation URL and login ID they used prior to the AWS migration. 

New customers will use the production URL with the appended login ID, which will include the appended domain (for example, johnsmith@123.com.uat). 
This change will help to safeguard against any conflicts with production login IDs. 
User Creation: Additionally, clients can use the exact same employee import files as they would in production. The uat domain will also be applied to all aspects of user creation: FTP import, Excel import, entity restore, and more.
Extracts: When generating accounting extracts or financial integration documents, SAP Concur will automatically remove the uat domain from login IDs that were appended during user creation. This will help to generate realistic extracts without requiring any actions from the clients, such as removing the appended domain.
These changes apply to PSEs once they are moved or created in the AWS environment, which will occur at a future date.
Business Purpose / Client Benefit
Once in AWS, PSEs will benefit from the same stability, monitoring capabilities, and level of performance as production entities.
Configuration / Feature Activation
These changes occur automatically; there are no additional configuration or activation steps.
[bookmark: _Toc93667427]**Ongoing** Unique Address Required for PSE Email Verification

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 2021 
	January 21, 2021
	October 1, 2021 through mid-2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93667428]Expense, Invoice, Request | Professional
Overview
Some SAP Concur users use Production Sandbox Environment (PSE) entities to set up, test, and train on new configurations prior to deploying them to their live production entity. SAP Concur plans to migrate PSEs as part of our move to Amazon Web Services (AWS).
For more information, refer to the SAP Concur Cloud Platform Strategy FAQ.
When PSEs are migrated to the AWS production environment, verified emails from the existing PSE will not carry over to the new PSE. As a result, when users test verified email functionality in a future PSE, it is recommended that the employee uses an email that is different from the email configured in their production entity. This process is required as the email in the existing PSE was most likely already verified in production and, therefore, cannot be verified in another entity.
With respect to user email addresses, the Receipt Recognition service validates user email addresses and as such, only one instance of an email address can be associated with a user account. To test in production, clients will be required to utilize alternate email addresses that are not currently associated with any production user account. If a client attempts to set up a test account in production using an email address already associated with a corresponding user profile, it will fail the validation process.
These changes apply to PSEs once they are moved or created in the AWS environment, which will occur at a future date.
Business Purpose / Client Benefit
Once in AWS, PSEs will benefit from the same stability, monitoring capabilities, and level of performance as production entities.
What the Admin Sees
BEFORE – Existing Email in Existing PSE
[image: Before screenshot of Existing Email in Existing Test Entity]
AFTER – New Email in New/Future PSE
[image: After screenshot of New Email in New/Future Test Entity]
Configuration / Feature Activation
These changes occur automatically; there are no additional configuration or activation steps.
[bookmark: _Toc93667429]User Assistance for End Users
[bookmark: _Toc93667430]New Tours Added to User Assistance for End Users and Admins (US, EMEA)

	[bookmark: _Hlk92986776]Information First Published
	Information Last Modified
	Feature Target Release Date

	January 14, 2022
	--
	January 22, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93667431]Travel, Expense, Request, Budget | Professional & Standard
Overview
The SAP Concur January release includes new User Assistance content (tours). The new tours expand the scope of information provided by User Assistance for End Users and Admins.
The following new tours are included in the January release:
· Concur Travel
How do I book a hotel?
· Concur Expense
View Expense Details
Move Items
Delete an expense
Combine expenses
Edit multiple expenses
· Concur Request
View audit trail and Request timeline
Submit a cash advance
Add attendees to expected expenses
· Concur Budget
Create a team budget
Make an adjustment to a team budget
Business Purpose / Client Benefit
User Assistance for End Users and Admins assists users and admins to learn new tasks more quickly and efficiently by providing guided tours with step-by-step instructions for completing a task. Enabling users to learn and complete tasks more easily drives user adoption, increases efficiency, improves user experience, and improves user satisfaction with SAP Concur solutions.
Configuration / Feature Activation
On entities with User Assistance for Admins enabled, user assistance for end users can be enabled and disabled by country/region or globally on the User Assistance Settings page.
Standard Edition
Admins with the necessary permissions can navigate to the User Assistance page by clicking Administration > Company > Tools > User Assistance.
Professional Edition
Admins with the necessary permissions can navigate to the User Assistance page by clicking Administration > Company > Company Admin > User Assistance.
SAP Concur clients who do not have User Assistance for Admins enabled can open a service ticket to enable the feature. Once User Assistance for Admins is enabled, the client admin can also enable and disable User Assistance for End Users.
[bookmark: _Toc93667432]Web Services Administration
[bookmark: _Toc31271709][bookmark: _Toc93667433]**Ongoing** Application Connector Username and Password Length Requirements Updated

	Applies to:
	Expense
	Invoice
	Request
	Travel
	Other

	Edition(s)
	Professional
Standard
	--
	Professional
Standard
	--
	Web Services

	Information First Published
	Information Last Modified
	Feature Target Release Date

	January 14, 2022
	January 14, 2022
	February 28, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93667434]Expense, Request, Web Services | Professional & Standard
These changes are part of the SAP Concur continued commitment to maintaining secure authentication.
Overview
To meet new security requirements, the length of the username and password associated with an application connector on the Application Connectors page must be at least 10 characters long and not more than 50 characters long. 
Some clients currently have usernames and passwords configured that do not meet these parameters. 
On February 28, 2022, the 10-character minimum and 50-character maximum will be enforced. If the usernames and passwords are not updated prior to this change, some aspects of SAP Concur solutions might stop working. For example, workflow steps will not complete if using notifications, LEU windows will not open, and there will be no results in fields using fetch lists.
To avoid disruption of callouts through application connections and subsequent disruption of some end-user tasks, SAP recommends updating your application connector username(s) and password(s) as soon as possible.
Application connection usernames and passwords can be updated by an administrator with the Company Administrator or Web Services Administrator role.
For admins working with Standard entities, a user with the Concur Expense Can Administer permission has the Web Services Administrator role.
Business Purpose / Client Benefit
Enforcing password and username length restrictions improves the security standards for callouts made through the application connector.
Configuration / Feature Activation
Usernames and passwords for application connectors are configured on the Manage Application Connectors page. 
To change the username and password for an application connector:
1. Click Administration > Company > Web Services.
[image: ]
Click Manage Application Connectors.
[image: ]
Choose the application connector you want to update and then click Modify.
[image: ]
Enter the new username and password and then click Test Connection.
[image: ]
Click Save.
After you update the username and password for an application connector, you must click Test Connection to verify the changes before the application connector can be used for any of the callout services. 
For more information, refer to Callouts and Application Connectors on the SAP Concur Developer Center.
[bookmark: _Toc93667435]Planned Changes
[bookmark: _Hlk92890624]The following features and changes are targeted for future releases. SAP Concur solutions reserves the right to postpone implementation of – or completely remove – any enhancement/change mentioned here. 
[bookmark: _Toc46229145][bookmark: _Hlk523311325][bookmark: _Toc478727899][bookmark: _Toc93667436]Fax Feature
[bookmark: _Toc93667437]**Planned Changes** Fax Feature to be Decommissioned

	Information First Published
	Information Last Modified
	Feature Target Release Date

	November 2021
	January 14, 2022
	October 1, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93667438]Expense, Invoice | Professional & Standard
Overview
On October 1, 2022 the Concur Fax Feature will be decommissioned.
[bookmark: _Hlk86919337]The Fax feature was retired in 2020. Clients onboarded after July 15, 2020 do not have access to this feature. Among clients with access, very few use the feature regularly and, among those that use it, use has declined steadily.
Business Purpose / Client Benefit
Removal of the Fax feature improves the security, performance, and scalability of SAP Concur solutions. 
In addition, The Concur Fax Feature attaches files only at the header level of expenses and invoices. As a result, clients who use the Fax Feature cannot take advantage of recent innovations that apply only to images and attachments at the line-item level.
What the User Sees
Users will no longer have the option to print Fax cover pages from within Concur Expense or Concur Invoice and they will no longer have the ability to fax images to SAP Concur for attachment to expenses or invoices.
Configuration / Feature Activation
This change occurs automatically; there are no configuration steps. 
Additional information about this change will be made available over the coming months.
[bookmark: _Toc79737887][bookmark: _Toc93667439]Product Settings
[bookmark: _Toc93667440]**Planned Changes** Advanced and Basic Views Added to Product Settings

	Information First Published
	Information Last Modified
	Feature Target Release Date

	January 21, 2022
	--
	February 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93667441]Expense, Invoice, Request | Standard
Overview
SAP Concur plans to add the ability to switch between basic and advanced views in Product Settings.
Prior to this change, changing the view between basic and advanced settings in Product Settings required the assistance of an SAP Concur internal administrator.
Business Purpose / Client Benefit
This change enables client admins to view or hide their advanced settings as needed without assistance from SAP Concur personnel. 
What the Admin Sees
By default, only the basic tiles appear on the Product Settings page. When an admin navigates to Product Settings, they see the basic tiles and they see the View Advanced Settings link under the Product menu in Product Settings.
[image: ]
When the admin clicks View Advanced Settings, the advanced tiles appear on the Product Settings page, and the link under the Product menu changes to View Basic Settings.
The settings tiles that appear in advanced view vary depending on your configuration. 
When an admin switches to advanced view, the view persists only for the current session. If the admin signs out of their SAP Concur product, when they sign back in, the view will be reset to the basic (default) view.
Configuration / Feature Activation
This change occurs automatically; there are no configuration or activation steps.
[bookmark: _Toc93667442]Profile Settings
[bookmark: _Toc93667443]**Planned Changes** Removing Connected Apps Page

	Information First Published
	Information Last Modified
	Feature Target Release Date

	January 14, 2022
	--
	Q1 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93667444]Travel, Expense, Invoice, Request | Professional & Standard
Overview
SAP Concur plans to remove the Connected Apps page in Profile Settings.
Business Purpose / Client Benefit
Periodically, under-utilized features or pages are removed to improve usability. This is a rarely used page; it no longer meets its purpose of driving partner application usage.
What the User Sees
When a user navigates to Profile > Profile Settings, they will no longer see the Connected Apps link under Other Settings.
Before
[image: ]
After
[image: ]
The user will no longer have access to the Connected Apps page.
[image: ]
Users can continue to connect to available apps through the App Center. A link to the App Center is available in the SAP Concur page header.


[image: ]
Configuration / Feature Activation
This change occurs automatically; there are no configuration or activation steps.
[bookmark: _Toc93667445]SAP Concur Support
[bookmark: _Toc93667446]**Planned Changes** Suggested Solutions Migration

	Information First Published
	Information Last Modified
	Feature Target Release Date

	November 5, 2021
	January 14, 2022
	Q1 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93667447]All Products & Services | Professional & Standard
Overview
Targeted for Q1 2022, the Solution Suggestions platform that SAP Concur provides will be migrated into the SAP Continuous Influence – Improvement Requests program. 
This change will provide a better user experience and a single place for Authorized Support Contact (ASC) users to engage with all SAP Concur Customer Influence programs. 
Tool usage for ConcurGov and Concur Cloud for Public Sector clients is still being evaluated. Additional information for these impacted client groups will be shared in the near future.
For more information, refer to SAP Continuous Influence Sessions.
Business Purpose / Client Benefit
In addition to offering a better tool with more functionality, SAP Concur is enhancing the process of how improvement requests will be reviewed, considered, and prioritized. 
What the User Sees
Beginning with the November release, Authorized Support Contact users saw an updated Suggestions section on the Contact Support page. 
Depending on the user’s Support access level, the Suggestions section may or may not appear.
Before Update
[image: ]
After Update
[image: ]
Configuration / Feature Activation
The change will occur automatically; there are no additional configuration or activation steps.
[bookmark: _Toc93667448]SAP Concur User Assistance
[bookmark: _Toc93667449]**Planned Changes** Notice Regarding Stale Documentation

	Information First Published
	Information Last Modified
	Feature Target Release Date

	January 14, 2022
	—
	Q1 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93667450]All Products & Services | All Editions
Overview
SAP Concur User Assistance will archive and eventually delete documents as needed to maintain accurate, relevant, and concise information for all supported audiences including end users and their administrators, along with SAP Concur support and implementation colleagues. 
Archiving activities performed by SAP Concur User Assistance will comply with data retention best practices and adhere to legal compliance requirements.
The initial exercising of this notice will apply to the archiving of stale (example) online help documents currently available on the concurtraining.com server. All current online help documents are now located on the SAP Help Portal.
For more information, refer to the Help Menu Directed to SAP Help Portal release note in the November 2021 product release notes. 
IMPORTANT: SAP Concur User Assistance considers this notice sufficient to cover the future archiving of documents not specifically mentioned here at such time as we deemed them stale. Further notices are not planned. 
Business Purpose / Client Benefit
This notice serves to expedite the appropriate archiving of stale documentation.
Configuration / Feature Activation
Archiving will occur automatically; there will be no configuration or actions required. Bookmarks to the archived content will no longer work. Refer to the SAP Help Portal for the current links to deliverables:
Concur Expense: 
https://help.sap.com/viewer/product/CONCUR_EXPENSE/LATEST/en-US
Concur Invoice: 
https://help.sap.com/viewer/product/CONCUR_INVOICE/LATEST/en-US
Concur Request: 
https://help.sap.com/viewer/product/CONCUR_REQUEST/LATEST/en-US
Concur Travel: 
https://help.sap.com/viewer/product/CONCUR_TRAVEL/LATEST/en-US
[bookmark: _Toc510082427][bookmark: _Toc12880017][bookmark: _Toc46229154][bookmark: _Toc11147478][bookmark: _Toc93667451]Client Notifications
[bookmark: _Toc69211924][bookmark: _Toc480899347][bookmark: _Toc483562026][bookmark: _Toc484092107][bookmark: _Toc480899345][bookmark: _Toc483562024][bookmark: _Toc484092109][bookmark: _Toc510082430][bookmark: _Toc514338227][bookmark: _Toc12880020][bookmark: _Toc46229157][bookmark: _Toc93667452]Accessibility
[bookmark: _Toc69211925][bookmark: _Toc93667453]Accessibility Enhancements
SAP implements changes to better meet current Web Content Accessibility Guidelines (WCAG). Information about accessibility-related changes made to SAP Concur solutions is published on a quarterly basis. You can review the quarterly updates on the Accessibility Updates (English Only) page.
[bookmark: _Toc93667454]Subprocessors
[bookmark: _Toc93667455]SAP Concur Non-Affiliated Subprocessors
The list of non-affiliated subprocessors is available here: SAP Concur list of Subprocessors
If you have questions or comments, please reach out to: Privacy-Request@Concur.com
[bookmark: _Toc77840903][bookmark: _Toc93667456]Supported Browsers
[bookmark: _Toc77840904][bookmark: _Toc93667457]Supported Browsers and Changes to Support
For information about supported browsers and planned changes to supported browsers, refer to the Concur Travel & Expense Supported Configurations guide.
When changes to browser support are planned, information about those changes will also appear in the Shared Planned Changes release notes.
[bookmark: _Toc90037239][bookmark: _Toc93667458]Additional Release Notes and Other Technical Documentation
[bookmark: _Toc90037240][bookmark: _Toc93667459]Online Help
Any user can access release notes, setup guides, user guides, admin summaries, monthly browser certifications, supported configurations, and other resources via online Help or directly on the SAP Help Portal.
Use the links in the Help menu in the app, or search for your SAP Concur product (Concur Expense, Concur Invoice, Concur Request, or Concur Travel) on the SAP Help Portal (https://help.sap.com) to view the full set of documentation for your product.
[bookmark: _Toc90037241][bookmark: _Toc93667460][bookmark: _Toc530557893]SAP Concur Support Portal – Selected Users
Access release notes, webinars, and other technical documentation on the SAP Concur support portal.
If you have the proper permissions, Contact Support appears on the Help menu. Click to access the SAP Concur support portal, then click Resources. 
Click Release/Tech Info for release notes, technical documents, etc. 
Click Webinars for recorded and live webinars.
[image: P1891#yIS1]
© 2022 SAP SE or an SAP affiliate company. All rights reserved.
No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP SE or an SAP affiliate company. 
SAP and other SAP products and services mentioned herein as well as their respective logos are trademarks or registered trademarks of SAP SE (or an SAP affiliate company) in Germany and other countries. Please see http://global12.sap.com/corporate-en/legal/copyright/index.epx for additional trademark information and notices. 
Some software products marketed by SAP SE and its distributors contain proprietary software components of other software vendors. 
National product specifications may vary. 
These materials are provided by SAP SE or an SAP affiliate company for informational purposes only, without representation or warranty of any kind, and SAP SE or its affiliated companies shall not be liable for errors or omissions with respect to the materials. The only warranties for SAP SE or SAP affiliate company products and services are those that are set forth in the express warranty statements accompanying such products and services, if any. Nothing herein should be construed as constituting an additional warranty. 
In particular, SAP SE or its affiliated companies have no obligation to pursue any course of business outlined in this document or any related presentation, or to develop or release any functionality mentioned therein. This document, or any related presentation, and SAP SE’s or its affiliated companies’ strategy and possible future developments, products, and/or platform directions and functionality are all subject to change and may be changed by SAP SE or its affiliated companies at any time for any reason without notice. The information in this document is not a commitment, promise, or legal obligation to deliver any material, code, or functionality. All forward-looking statements are subject to various risks and uncertainties that could cause actual results to differ materially from expectations. Readers are cautioned not to place undue reliance on these forward-looking statements, which speak only as of their dates, and they should not be relied upon in making purchasing decisions.
SAP Concur Release Notes	Page 4	Shared Changes
Release Date: January 22, 2022		Client Final
Initial Post: Friday, January 21, 2022
image1.png
Administrationv | Help~

SAP Concur Requests Travel Expense Invoice Approvals Reporting v App Center .

Profile v -
M|
K| PLACEHOLDER + 00 00 00 00 01
He||0, WS New Required Authorization Invoices Available Open
Approvals Requests Expenses Reports
TRIP SEARCH ALERTS

o Triplt creates a schedule with all your travel details in one place, accessible on Android or iPhone.

& Booking for myself | Book for a guest
Simply connect your Concur account to Triplt. Not right now

»f = = © You haven't signed up to receive e-receipts.@ Sign up here
Flight Search

Round Trip One Way Multi City COM PANY NOTES
From @

Departure city, airport or train station Concur Training Toolkit

Find an airport | Select multiple airports This link will provide information to utilise the Concur Expense System.
To®
Arrival city, airport or train station Book travel with Concur, check travel rules set by your company, get travel maps, and more.
Find an airport | Select multiple airports E-
m Read e
MY TASKS
Show More
Required Approvals = Available Expenses = Open Reports -
MY TRIPS (0) -
Great! You currently have no approvals. You currently have no available 09/25 Test report

You currently have no upcoming trips. expenses.




image2.png
Requests  Travel  Expense  Invoice  App Center

ALERTS

You have been successfully logged in, but unfortunately one or more of our services appears to be unavailable at the moment. While we work to fix the outage, you still may be
able to use some services.

= The tiles below show reen if the service appears to be working, and red if the service appears to be unavalable.

= You may try using a service by ciicking is e or the associated menu option. Services that show red may not function as expected.

« Ifyouneed a service that isn't available, you can log out and iry again at a later time

MY APPLICATIONS

Home Requests Travel Expense

Invoice App Center

SAP Concur

Processor Privacy Statement

‘Travel Policy

Service Status (North America)
Contact Support

‘Cookie Preferences © Copyright 2020 - SAP Concur - All Rights Reserved




image3.png
Invoice Manager
MY TASKS

‘ Required Approvals ‘
Sony,someting went wrong,

App Center





image4.png
SAP Concur Requests Travel Expense Invoice Approvals Reporting v App Center

| PLACEHOLDER + 00 00 00

Hello, WS New Required Authorization

Approvals Requests Invoices

TRIP SEARCH ALERTS

o Triplt creates a schedule with all your travel details in one place, accessible on Android or iPhone.

& Booking for myself | Book for a guest .
Simply connect your Concur account to Triplt. JEEGRVCEEGEVASIEEY  Not right now

Administration v

Profile v

00 01

Available Open
Expenses Reports

,f Q |'— o You haven't signed up to receive e-receipts.@ Sign up here
Flight Search
Round Trip One Way Multi City COM PANY NOTES
From @
Departure city, airport or train station Concur Training Toolkit

Find an airport | Select muttiple airports This link will provide information to utilise the Concur Expense System.

To®

Arival city, airport or train station Book travel with Concur, check travel rules set by your company, get travel maps, and more.
Find an airport | Select multiple airports

o e MY TASKS
Required Approvals —> Available Expenses —> Open Reports ->
MY TRIPS (0) -
Great! You currently have no approvals. You currently have no available 09/25 Test report

You currently have no upcoming trips. expenses.





image5.png
Administration~ | Help~
Requests  Expense  Invoce  Approvals  Anaics = 'Y

Profie +
-

SAP Concur + 07 03 00 07

Helo, Authorization  Purchase Available Open

New Requests. Reguests Expenses Reports

Susan
Iy





image6.png
Administration~ | Help~

oe + &)
Prone ~ &

)

Profie Setings | Sign Out

/2 Acting as other user @
ey raneor

concel

L RE





image7.png
NewTheme On





image8.png
Changing Theme Requires Page Refresh

Changing themes requires the page to refresh. Any unsaved
data on this page will b lst. Are you sure you want fo
continue?





image9.png
NewTheme





image10.png
Client Admin

X Actas Another User
£ Proie Setings

@ sgnou





image11.png
Your Information

Personal Information
Company Information
Contact Information
Email Addresses

Request Settings

Request Information
Request Delegates
Request Preferences.
Request Approvers
Favorite Atiendees.
International Travel

Expense Settings

Profile Options

Select one of the following to customize your user profie.

Personal Information
Personal Information

Expense Delegates
Delegates are employees who are allowed
0 perform work on behalfof other
empioyees.

Expense Preferences
Select the options that define when you
receive emal notficatons. Prompis are
pages that appear when you select acertain
action, such as Submit or Print.

‘System Settings
Which ‘3 jzone are you in? Do you prefer
10 use a 12 o 24-hour clock? When does.
your workday startend?

Request Preferences
Select the options that define when you
receive email notficatons. Promprs are
pages that appear when you select a certain
action, such as Submitor Print.

Company Car
Company Car





image12.png
System Settings

Detaut Language [ Engion (United Statss) v

NomberFormt|

Pcemene o Cureney Sy

Negatie Humber Format

Negatie Curency Forma

e

Houinue Separacr| 011102022 05:49 pm

Time zone (oca tme)

Catendar Setings

st
N rxa
vt oo v |

Deteut iew|

Other Preferences

S —

[rcoste covenrre w5 cong

Rows pr page
Aope:
cus the visual appearance of SAP

Goncur for increased contrast or for work in
environments where low light is necessary or
unavoidable,

SEF Gz gt v

54 Quarz Light

‘54 Quarz Dark

High Contast Black





image13.png
ExpenseUser ExpenseUser





image14.png
NewTheme on () @) .

ExpenseUser ExpenseUser

{3} Profile Settings

(1) signout





image15.png
Company Admin

i Profile Settings Sign Out

/3 Acting as other user @

® Actas user in assigned group (Proxy)
O Book travel for any user (Self-assign)

Search by name or ID Q)

Cancel





image16.png
New Theme  On

Company Admin

2 Act as Another User

{3} Profile Settings

() signout





image17.png
New Theme  On

Company Admin

2 Act as Another User

Acting As @

® Myself
O User in an assigned group (Proxy)

O Travel arranger for any user (Self-assign)

{3} Profile Settings

() signout





image18.png
Profile ~

Company Admin

il Profile Settings Sign Out

/3 Acting as other user @

® Actas user in assigned group (Proxy)
O Book travel for any user (Self-assign)

ExpenseUser, ExpenseUser Q)





image19.png
New Theme  On

Company Admin

2 Act as Another User A~
Acting As @

O Myself
@ User in an assigned group (Proxy)

O Travel arranger for any user (Self-assign)

ExpenseUser, ExpenseUser | Switch

{3} Profile Settings

() signout





image20.png
Acting as ExpenseUser,

ExpenseUser

) &% Currenty acting as ExpenseUser, ExpenseUser

Profile Settings Sign Out

/3 Acting as other user @

® Actas user in assigned group (Proxy)
O Book travel for any user (Self-assign)

Search by name or ID Q)

Cancel

Dol





image21.png
Acting as ExpenseUser,

&% ExpenseUser

2% ExpenseUser, ExpenseUser

2 Act as Another User A~

Acting As @

@© Myself
O Userin an assigned group (Proxy)

O Travel arranger for any user (Self-assign)

{3} Profile Settings

(1) signout





image22.png
J g
114 ‘ 5 I
§ §
afafzf. /85 § il g
glelglzl3]8 ] s &
& Ale|a =< <
| Akamai/OpenSSL cipher names Existing cerificates only TLS versions. Signature IANA cipher names
e gl Z e Tl
b Al 2 O e e s S [
TLsAES 25 GoMSMAIS gl Z B e Bt e
sy 7z z TS T
Hosrore ealF Z B [ e s S
s
* [Foone rsses2s coarsiaanr gl . | |/ [V [ =i B oot
= I EAFAFAEAR 5 e e
< [EconeRsacHACHAZ0 POLY1305 v v 7 v v 7 |75 ECOHE RsA WiTH CHACHA20_ POLY1305 SHA256_|300GGAB] 0xCC.0xA8
e T EARAFARARARA | Ao AW e o e s v el
e = | EATAEARARAEA [ i s s
e = | EArAFAEAEAFRA AN e T i (i
e = | EAeAFAEAEARE BRI ey e [
B L eARACARARREAl 1L | e B
e el . | < || [ | |mnEaeaeEmims s St
T . EARARARAEARA |- 7 . T
-  EAFAFAEAEAEA | 7 i casts g
i AN v 7 wase 300005 | 000
5 2 A 2 P2 FA A I o000ss | 000
i  EARARARAEAEA | oo [ oot
e 5 alEalRalE oo s
&= ACACACs ot [GEmsd
e ARARARA | ot [ o





image23.png
Last login: Thu May 27 16:

15062260C02XT30Q3GHS ~ % sudo nanao /private/etc/hostsl]





image24.png
Al Apps  Documents  Settings  Photos

Best match
7] Notepad
App O Run as administrator
&
Apps 0 Open file location
® Notepad2 58 Unpin from Start >
& sticky Notes <3 Pin to taskbar >
M Uninstall

Documents - This P¢





image25.png
File name: Text Documents (*:txt) =

Text Documents (*txt)





image26.png
# Additionally, comments (such as these) may be inserted on individual
#lines or following the machine name denoted by a # symbol.

#

# For example:

#

# 102549497  rhino.acme.com # source server

# 38256310 xacme.com #x client host

# localhost name resolution is handled within DNS itself.
# 127001 localhost
# A localhost

104.76.225 252 www concursolutions.com





image27.png
Add Expense

15 +

Available Expenses | Create New Expense

‘ Search for an expense type

~Recently Used
Taxi
Gomputer Supplies
Hotel
Miscellaneous
Airfare.

~01. Travel
Airfare.
Car Rental

Car Rental - Insurance.




image28.png
Air Ticket $1,234.00 @

‘ Round Trip ‘ One Way ‘ Multi City ‘

Outbound

From*

[ ® v | Charles D Gaulle Intl (Airport - CDG), Paris, FRANCE

Date * Recently Used

‘ 06/03/2 Charles De Gaulle Intl (Airport - CDG), Paris, FRANCE
1 Haneda (Airport - HND), Tokyo, JAPAN

Class

No Results Found

None S





image29.png
Role(s)

) Request User (] Recuest rover B Epense User [ (0] uthorizea Support Contact
General Settings
CTE Login tamer Passons Verty Passuore”
(must be suffixed with & valid domain) (Blank to leave unchanged)
[fomnsmin@abe com ] [ i
e st Name* il Name Nikname LastNamer
sohn I I | [smin

Sutx

|

Acsoun Acvaton Date
B )

Employee ID

*(required for Expense, Invoice or Request User)
e ]

Account Temination Date

[

Emal Address





image30.png
Role(s)

) Request User (] Recuest rover B Epense User [ (0] uthorizea Support Contact
General Settings

CTE Login tamer Passons Verty Passuore”

(must be suffixed with & valid domain) (Blank to leave unchanged)

[jommsmitn@x2123 com i I ]
e st ame e ame U Lasttiamer

( V] son I I ) [sman J
sum__

(I

Acsoun Acvaton Date
B )

Employee ID

*(required for Expense, Invoice or Request User)
.





image31.png
App Center

03

Authorization
Requests

Expense & Invoice Settings
Tools jCumpasy

Expense User Experience Setings
3 wu

Ices Available
Capture Admin Settings Expenses

Web Services

Change Log

Authentication Admin





image32.png
Expense & Invoice Settings

Web Services
Enable Partner Application
Manage User Applications

Manage Application
Connectors

API Documentation
Support

WSAdmin Access
Configuration

Manage Travel Suppliers

Company~  Expense User Experience Settings

Partner Application Administration

API Documentation Support
Access web services documentation Access technical support

e Application Connectors
njﬁ application connectors used for outbound web

service calls.

Enable Partner Application
Enable or disable partner applications

Manage User Applications
Hide or Disable user applications. WSsAdmin Access Configuration
Change web service access level for Web Service Admin users.





image33.png
Application Connector Registration

e

ik hers 1o oy th applation connecor.





image34.png
System

Name [Rpptcaton one | Hesthame [t Apptctionone . com

f— ‘ vsertiame: [Usomame 1

Password (





image35.png
SAPConcr[E] e Aeve Ao

Settings Product: | experse v |

DY

Deployment Toolkit . §
Resources for rofing SAP Gonci out to your company e | Deptoment ookt





image36.png
Other Settings

ConcudMpanect

Concur Mobie Registation





image37.png
Other Settings
System Setings
Concur Connect
Change Password
Concur Moble Registration




image38.png
Adminisiration v

SAP Concur ave g App Center ot
o

Profle  Personal Information  Change Password  System Settings  Concur Mobile Registration  Travel Vacation Reassignment

Your Information Connected AppS

Personal Information
Company Information Link your Concur account with the following partners.
Contact Information
Email Addresses
Sponsored Guest Users
Emergency Contact
Credit Cards

When you enale Trtlgraton, Concu Travl v ulomatcl send your st il Comet o Topt
Trmlf

Travel Settings
Travel Preferences
Intemnational Travel
Frequent Traveler Programs
Assistants/Arrangers

Other Settings

System Settings

Connected Apps

Concur Connect

Change Password

Travel Vacation Reassignment
Registration

Concur Mobil
I'm Assisting




image39.png
Requests  Expense  Invoce  Approvals  Anabfics | AppCenter

SAP Concur




image40.png
UGGESTION:

What would improve your travel booking, expense reporting process? Share with us your ideas for
Invoice and Mobile! We know you've got suggestions for Concur and we want to hear them!





image41.png
**Planned Changes™*

Coming Q12022 Concur Solution Suggestions is evalving to the SAP Continuous Influence -
Improvement Requests platform. This change offers not only a better experience, but a single
place for youto engage with all of our Customer Influence programs

Tolearmmore, please visit our Continuous Influence information page.

Suggestions submitted after December 1, 2021 will not be reviewed i order to support this
change. If you have a great idea you'd like to share, make sure to come back here in QL to
submit your Improvement Request!





image42.png
Administration ~

Requests Travel Expense. Invoice Approvals Reporting + App Center Links ~ Training

Travel Administration Help

00 00 00 Expense Administration Help

Required Authorization Payment
Hello, Chris q v

Invoice Administration Help
Approvals Requests Requests

Request Administration Help

TRIP SEARCH MY TASKS — Contact Support

EY| sAP Concur e oo |

e SAP Concur

Re{easeﬂe%ln!u

Communtty Info Biling

Release Notes and Technical Documentation Knowledge Base | Release/Tech Info  Training Webmavs«

Concur Professional/Premium edition includes Expense, Trave, Invof

Brief description of the monthly re]
Fulldescription of the monthly releases
‘Galendar for the monthly releases Monthly Travel Release Recordings
Setup Guides and User Guides Listen to the monthly release recording and view the release
PowerPoint PDFs for Travel.

For Web Services, access

Fact Sheets Register for Travel Release Review Concur Support Training

are available for Travel & Expense, Expense, Invoice, Im|

To register for an individual call The Getting the
ciick the date below, or Customer Supp
to register for muliple calls educates Autho

Contacts (ASCs





